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Agena MassARRAY DICER1 Assay  

 
 

Purpose 

 
This procedure provides instructions for preparing samples and reagents, setting up multiplex, polymerase 
chain reaction (PCR) and Matrix-Assisted Laser Desorption Ionization Time-of-Flight Mass Spectrometry 
(MALDI-TOF) reactions using the Agena Bioscience MassARRAY DICER1 assay on Formalin-Fixed, Paraffin-
Embedded (FFPE) tumor tissue.   

 

 

Policy Statements 

 

This procedure applies to all technical staff performing testing on the Agena MassARRAY instrument.  
 

 

Principle and 

Clinical 

Significance 

 

 
The DICER1 gene provides instructions for making the Dicer protein which plays a role in regulating the 
expression of other genes. The Dicer protein aids in the production of a molecule called microRNA (miRNA). 
MicroRNAs are short lengths of RNA. Dicer cleaves precursor RNA molecules to produce miRNA. MicroRNAs 
control gene expression by blocking the process of protein production. In the first step of making a protein from 
a gene, messenger RNA (mRNA) is formed and acts as the blueprint for protein production. MicroRNAs attach 
to specific mRNA molecules and stop the process by which protein is made. Sometimes, miRNAs break down 
the mRNA, which also blocks protein production. Through this role in regulating the expression of genes, Dicer 
is involved in many processes, including cell growth and proliferation and the maturation of cells to take on 
differentiation.3 

 
Mutations in the DICER1 gene can cause DICER1 syndrome. People with this condition have an increased 
risk of developing many types of tumors, particularly certain tumors of the lungs (pleuropulmonary blastoma), 
kidneys (cystic nephroma), ovaries (Sertoli-Leydig tumors), and thyroid (multinodular goiter). Most of these 
mutations lead to an abnormally short Dicer protein that is likely unable to produce miRNA. Without regulation 
by miRNA, genes are expressed abnormally, which could cause cells to grow and divide uncontrollably and 
lead to tumor formation.3 

 
The DICER1 Panel for use on the MassARRAY system, is a multiplex Polymerase Chain Reaction, Matrix-
Assisted Laser Desorption Ionization – Time of Flight (PCR/MALDI-TOF) test intended for single nucleotide 
variant (SNV) and small indel genotyping and somatic mutation analysis of genomic DNA extracted from tumor 
tissue. Formalin-Fixed, Paraffin-Embedded tissue (FFPE) is the validated clinical sample type. A spin column 
based nucleic acid extraction on the QIACube Connect instrument is utilized.   
 
Following DNA extraction, PCR with iPLEX Pro chemistry then amplifies custom target regions of interest; after 
the inactivation of unincorporated dNTPs, a sequence-specific primer extension step is performed using the 
supplied custom set of Extend primers and iPLEX Pro reagents. Sample amplification is carried out on the 
Applied Biosystems 2720 and Veriti Thermalcyclers following the parameters listed in the iPlex Pro IFU.   
 
The extension products (analyte) are desalted, transferred to a SpectroCHIP Array (a chip with pre-spotted 
matrix crystals) and then loaded into the MassARRAY Analyzer (a MALDI-TOF mass spectrometer).  The 
analyte/matrix co-crystals are irradiated by a laser, inducing desorption and ionization.  The positively charged 
molecules accelerate into a flight tube towards a detector.  Separation occurs by time-of-flight, which is 
proportional to the mass of the individual molecules.  After data processing, a spectrum is produced with 
relative intensity on the y-axis and mass/charge on the x-axis.  Data acquired by the MassARRAY analyzer is 
processed by MassARRAY Typer software, and results then are interpreted.1    

 
The Agena Bioscience DICER1 panel consists of 68 variants in DICER1, DROSHA, FOXL2, TERT, and TP53 
genes interrogated by 37 assays divided into 6 primer sets.  See Tables 1 and 2 for details.     
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Table 1: Panel Variants 

 
 
Table 2: Panel Assay IDs and Primer Sets 

 
 
 

 

Test Code 

 

 

DICER1 – Formalin-Fixed, Paraffin-Embedded (FFPE) tissue.  

 

Sample 

 

A. Acceptable specimens:  

• Formalin-Fixed, Paraffin-Embedded (FFPE) tissue as scrolls or unstained sections. 

 

B. Unacceptable specimens:  

• Improperly labeled or unlabeled samples. 

Gene p. c. Gene p. c. Gene p. c. Gene p. c.

DICER1 p.A234V c.701C>T DICER1 p.D1709N c.5125G>A DICER1 p.G1809W c.5425G>T DICER1 p.E1813S c.5437_5438delinsTC

DICER1 p.N477S c.1430A>G DICER1 p.D1709Y c.5125G>T DICER1 p.G1809A c.5426G>C DICER1 p.E1813A c.5438A>C

DICER1 p.R656* c.1966C>T DICER1 p.D1709A c.5126A>C DICER1 p.G1809E c.5426G>A DICER1 p.E1813G c.5438A>G

DICER1 p.R688* c.2062C>T DICER1 p.D1709G c.5126A>G DICER1 p.G1809V c.5426G>T DICER1 p.E1813V c.5438A>T

DICER1 p.R937C c.2809C>T DICER1 p.D1709V c.5126A>T DICER1 p.D1810Y c.5427_5428delinsTT DICER1 p.E1813D c.5439G>C

DICER1 p.S1344L c.4031C>T DICER1 p.D1709E c.5127T>A DICER1 p.D1810H c.5428G>C DICER1 p.E1813D c.5439G>T

DICER1 p.G162D c.485G>A DICER1 p.D1709E c.5127T>G DICER1 p.D1810N c.5428G>A DICER1 p.Y1874* c.5622C>G

DICER1 p.E1705* c.5113G>T DICER1 p.D1713H c.5137G>C DICER1 p.D1810S c.5428-5429delinsAG DROSHA p.E1147K c.3439G>A

DICER1 p.E1705K c.5113G>A DICER1 p.D1713N c.5137G>A DICER1 p.D1810Y c.5428G>T FOXL2 p.C134W c.402C>G

DICER1 p.E1705Q c.5113G>C DICER1 p.D1713Y c.5137G>T DICER1 p.D1810A c.5429A>C TERT n/a c.‐124C>T (C228T)

DICER1 p.E1705A c.5114A>C DICER1 p.D1713A c.5138A>C DICER1 p.D1810G c.5429A>G TERT n/a c.‐146C>T (C250T)

DICER1 p.E1705G c.5114A>G DICER1 p.D1713G c.5138A>G DICER1 p.D1810V c.5429A>T TP53 p.R175H c.524G>A

DICER1 p.E1705V c.5114A>T DICER1 p.D1713V c.5138A>T DICER1 p.D1810E c.5430T>A TP53 p.R248W c.742C>T

DICER1 p.E1705D c.5115A>C DICER1 p.D1713E c.5139C>A DICER1 p.D1810E c.5430T>G TP53 p.R248Q c.743G>A

DICER1 p.E1705D c.5115A>T DICER1 p.D1713E c.5139C>G DICER1 p.E1813* c.5437G>T TP53 p.R273C c.817C>T

DICER1 p.D1709C c.5125_5126delinsTG DICER1 p.G1809A c.5425G>C DICER1 p.E1813K c.5437G>A TP53 p.R273H c.818G>A

DICER1 p.D1709H c.5125G>C DICER1 p.G1809R c.5425G>A DICER1 p.E1813Q c.5437G>C TP53 p.R282W c.844C>T

Primer Set 1 Primer Set 2 Primer Set 3

DICER1_c5127TtoAG DICER1_c5622CtoG DICER1_c2809CtoT

TP53_c743GtoA TP53_c742CtoT TP53_c817CtoT

TP53_c844CtoT DICER1_c5114AtoCGT TP53_c524GtoA

DICER1_c1966CtoT DICER1_c5113GtoACT DICER1_c5428GtoACT_r

DROSHA_c3439GtoA DICER1_c485GtoA FOXL2_c402CtoG

DICER1_c1430AtoG DICER1_c2062CtoT DICER1_c5427GtoT

DICER1_c5428GtoACT_f DICER1_c5430TtoAG DICER1_c5115AtoCT

DICER1_c5429AtoCGT DICER1_c701CtoT

Primer Set 4 Primer Set 5 Primer Set 6

DICER1_c5438AtoCGT DICER1_c5125GtoACT TERT_C228T

DICER1_c5137GtoACT DICER1_c5425GtoACT DICER1_c5439GtoCT

DICER1_c5138AtoCGT DICER1_c5126AtoCGT DICER1_c5139CtoAG

DICER1_c4031CtoT DICER1_c5426GtoACT TERT_C250T

TP53_c818GtoA

DICER1_c5437GtoACT
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• <40% tumor cellularity, with or without macrodissection (unless approved by molecular pathologist on 

case-by-case basis). 

• Decalcified specimens. 

C. Specimen Collection and Transport: 

• FFPE scrolls or slides received from histology department; room temperature. 

• Refer to Lab Test Directory on StarNet 

D. Specimen assessment: 

• Refer to the policy MB1.02v7 Specimen Rejection Criteria for Molecular Biology 

• Do NOT discard rejected samples unless approved by molecular pathologist. 

  

 

Special Safety 

Precautions 

 

 

• Standard precautions. Refer to MB 2.02 Biohazard Containment 

• Use of engineering controls: Refer to MB 3.01 Engineering Controls to Prevent Nucleic Acid 
Contamination 

Laboratory staff are subject to occupational risks associated with specimen handling. Refer to the safety 
policies located in the safety section of the Molecular Biology Policy Manual: 

• Safe Work Practices in Molecular  

• Biohazardous Spill in Molecular 

• Biohazard Containment 
 

1. Wear appropriate personal protective equipment (PPE) including disposable gloves and lab coats. 
2. Handle all samples and waste materials as if they were capable of transmitting infectious agents. 
3. Change gloves often when handling reagents or samples. 
4. Dispose of materials used in this assay, including reagents and used buffer vials, in biohazardous 

waste. 
 

Materials  

Reagents Supplies Equipment 

-Sani-Cloth Bleach wipes or 
1:10 diluted bleach solution 
-70% ethanol 
-100% ethanol 
-5% Extran 
-DNA Away 
-Deionized water (DI) 
-Nuclease Free Water (NFW) 
-Clean Resin 
-Ultrapure HPLC-grade water 
-Positive Amplification Control 
material  
-QIAamp DNA FFPE kit (REF 
56404) 
 
Room 1: 
MassARRAY DICER1 Panel 
Kit 
-Agena DICER1 Panel (REF 
06205) – store at -25 °C to -10 
°C: 

• DICER1 PCR Primers 

-Gloves (powder-free) 
-Filtered pipette tips, various 
sizes including 200 uL, 
extended tips 
-Sharps disposal container 
-Microtubes  
-Clear adhesive plate seals 
(ThermoFisher, Cat #: AB0558) 
-96 well semi-skirted, color 
microtiter plates 
-0.2 mL PCR strip tubes (8) 
-Reservoirs  
-QIAcube kit concumables 

• 1000 uL tips 

• 200 uL tips 

• RB Tubes 

• CB Tubes 

• Rotor adaptors  
 
-Eppendorf epMotion 50 uL tips 
-Eppendorf 1.5 mL Snap-cap 
tubes 

-Plate centrifuge 
-Vortex 
-Mini tube centrifuge  
-Tube centrifuge  
-Thermocycler 
-PCR work station with UV 
irradiation 
-Multichannel pipettes 
-Single channel Pipettes  
-Tube racks  
-Sealing paddle  
-SpectroCHIP arrays 
-10 to -30° C freezers 
-Laminar flow Hood 
-Refrigerators 2 – 8° C 
-BSC BSL-2 
-70⁰  C freezer 
-QIAcube Connect 
-Nanodrop 
-Agena MassARRAY with Chip 
Prep Module (CPM) 96, 
including: 

https://www.childrensmn.org/References/Lab/
https://starnet.childrenshc.org/References/labsop/molbio/specmgt/mb-1.02-rejection-criteria.pdf
https://starnet.childrenshc.org/References/labsop/molbio/safety/mb-2.02-biohazard-containment.pdf
https://starnet.childrenshc.org/References/labsop/molbio/engctl/mb-3.02-wipe-testing-for-amplicon-or-nucleic-acid-contamination.pdf
https://starnet.childrenshc.org/References/labsop/molbio/engctl/mb-3.02-wipe-testing-for-amplicon-or-nucleic-acid-contamination.pdf
https://starnet.childrenshc.org/References/labsop/index.php?view=folder&folder=molbio
https://starnet.childrenshc.org/References/labsop/molbio/safety/mb-2.01-safe-work-practices-in-molecular.pdf
https://starnet.childrenshc.org/References/labsop/molbio/safety/mb-2.03-biohazardous-spills-in-molecular.pdf
https://starnet.childrenshc.org/References/labsop/molbio/safety/mb-2.02-biohazard-containment.pdf
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• DICER1 Panel Extend 
Primers 

•  
-PCR Reagent Set (REF 
21327M) -  store at -25 °C to -
10 °C: 

• MgCl2, 25mM 

• 10x PCR Buffer 

• dNTP Mix 

• PCR Enzyme 
 

-iPLEX Pro Reagent Set (REF 
10212)- store at -25 °C to -10 
°C: 

• 3 Point Calibrant 

• iPLEX Termination Mix 

• iPLEX Buffer Plus, GPR 

• iPLEX Pro Enzyme 

• SAP Buffer 

• Shrimp Alkaline 
Phosphatase (SAP) 

 
NOTE: The MassARRAY 
DICER1 Panel Kit can be used 
up to ten times (freeze/thaw), 
as long as components are 
maintained on ice or a cold 
block during access and 
returned to storage conditions 
after use.   
 
NOTE: Keep all reagents in 
cold blocks once thawed and  
only take enzymes out of 
freezer immediately prior to 
use.  Mark white board for each 
freeze-thaw cycle.  

 
 
  
 

• Typer software v5.01 or 
greater 

• RT-Workstation v4.1 or 
greater 

• Chip Prep Controller 
v2.2 or greater  

 
-Eppendorf epMotion 5073 
-Eppendorf epMotion 5075 
-Eppendorf Thermorack TMX 
-Eppendorf Thermoadaptor  

 

Record shipment receipts on log: MP 4.02.F1 Agena DICER1 Kit and QC Inventory Log 

Calibration  

Annual instrument function check and maintenance performed by Agena BioScience.     
 

Quality Control 

 

 

See SOP: MP 4.02  Agena MassARRAY DICER1 Assay Quality Control 

 

Daily Quality Control: 

For extraction quality control, the Nanodrop will be used to assess DNA concentration and purity. 

 

External Quality Control: 

• Perform QC using an external positive control on a rotating basis based on primer set and a negative 

control with every run. 

• Perform QC using a previously tested positive sample (historical patient sample or positive synthetic 

control if patient sample is not available) for each primer set (positive TERT assay required for primer 

set 6), a previously tested negative sample for each primer set, positive QC (PC), and a negative 

control with new lot/shipments.  
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• Record and file results in the appropriate binder.  

• Positive Amplification QC – store at – 70 °C 

• Negative/Contamination QC (NTC) – Nuclease-free water 

 

 

QC Monitors: 
Control Control Monitor 

Historical Positive and 

Negative Patient (or 

synthetic control) 

Samples 

Reagent, instrument, equipment, or supply failure. 

Positive Amplification 

Control (PC) 
Reagent, instrument, equipment, or supply failure. 

Negative/Contamination 

Control (NTC) 

Reagent, instrument, equipment, or supply failure.  Environmental 

contamination monitoring. 

 

Record QC results on worksheet and log: 

MP 4.02.F1  Agena DICER1 Kit and QC Inventory Log 

MP 4.02.F2  Agena DICER1 New reagent QC worksheet 

MP 4.02.F3  Agena DICER1 QC Log 

 

• Before reporting patient results, all controls must yield valid results 

• If results are invalid, repeat testing 

 
Negative Control (NTC) 

1. Lot number (L/N), expiration date 
2. Record lot information in appropriate binder 

 
Positive Controls (POSC) – Rotating targets 

       1.    Previous positive patient 
       2.    Synthetic controls 
 
Test controls as you would patient samples. 

 

Record and file results in QC binder 

 
 

Control Type 
QC 

Status 
Expected Sample Result 

Historical 
Positive and 
Negative 
Patient (or 
synthetic 
control) 
Samples 

Pass Match to historical interpreted results 

POSC: 
Positive 
Amplification 
Control 

Pass Match to documented target 
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NTC: 
Nuclease-
free water 

Pass No Alleles 

 
 
NOTE: When reagents are in use, update the information on the reagent run prep worksheet. 
 

NOTE: Additional external quality control may be performed on an as needed basis if certain circumstances 

arise.  Examples include: 

• Drift in results (e.g., increasing/decreasing positivity rates) 

• Potential contamination (negative control) 

• After dramatic instrument maintenance or movement 

 

Assay Procedure: 

Sample 

Preparation and 

Extraction on 

QIAcube (Room 2) 

 
NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by DI water and alcohol before 
and after any sample processing  
 
Testing Preparation – Sample prep and DNA extraction: Room 2 

1. Open the DICER1 extraction worksheet template; SharePoint – Lab – Documents – Molecular – 
Molecular Pathology – Agena-Dicer1 – Forms and Worksheets – DICER1 QIAcube and Nanodrop 
Worksheet. 

2. Click File-Save As-Save a Copy  →  change name as described in Step 3 
3. Delete “- Copy” from the name and add the date (mm.dd.yy) in front of the File name followed by a 

space and save to DICER1 Run Worksheets. 
4. Fill out Date, Initial, Lot#, Exp, and Run name fields. 

NOTE: Format Run name as follows:  “mmddyy DICER1” 
a. e.g. March 3, 2020 = 030320 DICER1 

NOTE: Base runs off available chip spots in room 3 if applicable. 
 

Note: Store the QIAamp UCP MinElute columns at 2- 8oC. They can be stored up to 4 weeks at room 
temperature if necessary. The rest of the kit contents should be stored at room temperature. Expiration 
is 1 year after receipt. 

Note: Prior to first time use, prepare Buffer AW1 by adding 25 mL ethanol and Buffer AW2 by adding 30 mL 
ethanol, dating both bottles and checking the box to indicate they have been prepared.  

Note: Ensure the “2” shaker adapter is in place on the QIAcube for the FFPE protocol (not the S2). 
1. On the QIAcube, log in with username: Admin and password: Admin. Go to the Tools tab and then the 

Run Modules tab. Select Heat Shaker and set the temperature to 56oC at 8 rpm for 30 minutes to get 

the Heat Shaker up to temperature prior to loading the samples. 

2. Labeled Sample Tubes RB (990381) with the correlating FFPE sample in it will be delivered to 

Molecular from Histology along with the paper requisitions. 

3. Fill in the Sample ID fields on the DICER1 QIACube and Nanodrop worksheet and label the caps of 

the tubes with the corresponding QIACube Number from the worksheet. 

4. Centrifuge briefly. Add 300 uL Deparaffinization solution and vortex for 10 seconds. Centrifuge briefly. 

5. On the QIAcube, select Stop to terminate the preheat step. Load sample tubes. Set the temperature 

back to 56 oC at 8 rpm for 3 minutes and 30 seconds. Select Start. 

6. Cool to room temperature (around 7 minutes). If the solution becomes solid or waxy at room 

temperature, add another 300 uL deparaffiniazation solution and repeat the incubation. The blue 

solution should remain liquid at room temperature if it has completely melted the paraffin. 
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NOTE: A master mix that comprises the components in Step 8 may be prepared in advance during 

sample cool down. 

Samples Buffer FTB (uL) Ultrapure Rnase-free 

Water (uL) 

Proteinase K (uL) 

1 25.0 55.0 20.0 

2 52.5 115.5 42.0 

3 78.8 173.3 63.0 

4 105.0 231.0 84.0 

5 131.3 288.8 105.0 

6 157.5 346.5 126.0 

7 183.8 404.3 147.0 

8 210.0 462.0 168.0 

9 236.3 519.8 189.0 

10 262.5 577.5 210.0 

11 288.8 635.3 231.0 

12 315.0 693.0 252.0 

 

7. On the QIAcube, go to the Tools tab and then the Run Modules tab. Select Heat Shaker and set the 

temperature to 56oC at 8 rpm for 30 minutes to get the Heat Shaker up to temperature prior to loading 

the samples. 

8. If a master mix was prepared in advance during Step 6, add 100 uL of master mix to each sample. 

Otherwise, add 25 uL Buffer FTB, 55 uL ultrapure RNase-free Water, and 20 uL Proteinase K to each 

sample. Vortex and briefly centrifuge. 

9. On the QIAcube, select Stop to terminate the preheat step. Incubate for 1 hour and 3 minutes at 56oC 

and 1000 rpm onboard the QIAcube. 

10. Set the Eppendorf ThermoMixer F1.5 to 90oC by using the arrows to start heating. Insert the 

thermometer into the glycerin on top of the ThermoMixer. 

11. Once the QIAcube incubation has finished, take tubes out and place into the ThermoMixer at 90oC 

without shaking for 1 hour. 

12. After incubation, briefly centrifuge. 

13. There should be a complete phase separation. Remove and discard the upper blue phase using a 

fine-tip disposable pipet. Keep the lower ~100 uL aqueous lysate in the Sample Tube RB. This is the 2 

mL Eppendorf Safe-Lock Tube. 

14. On the QIAcube, go to DNA tab and select QIAamp DNA FFPE Advanced. 

15. Select material: FFPE Tissue and click Next. 

16. Select Protocol: DNA from FFPE and click Next. 
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17. Elution volume: 40 and click Next. 

18. Select the correct number of samples and click Next. 

19. Load Buffer Bottles with enough volume of each respective reagent as indicated on the screen.  

NOTE: Elution bottle should be filled with Ultrapure HPLC-grade water instead of Buffer ATE.                                 

NOTE: If opening a new QIAamp FFPE Extraction kit, prepare AW1 and AW2 by adding absolute 

ethanol. Follow bottle instructions for volumes. 

20. Click Next. 

21. Load Tip Racks.  

22. Prepare RNase A and Proteinase K in 1.5 mL elution tubes; volumes are shown on QIAcube screen. 

23. Label 1.5 mL elution tubes with Sample ID on the side and QIAcube number on the cap. 

24. Assemble Centrifuge Rotor Adaptors with the spin columns and elution tubes in the correct positions 

according to the screen diagram. Ensure lids are also in the correct location and pushed all the way 

down and at a 90o angle. Place assembly in numbered holding rack according to QIAcube Number on 

worksheet. 

25. Load Centrifuge Rotor Adaptors into the correct location in the instrument. 

26. Load the heat shaker with the Sample Tubes RB containing the specimens in the correct locations. 

27. Close lid and hit Start. Approximate run time is 80 minutes. 

28. Once the program is complete, open instrument and take out rotor apparatus, take out the spin column 

and dispose in a dual waste container, close elution tube and set in rack to be quantified on the 

Nanodrop. Dispose all reagents and consumables in a dual waster container. 

 
Assay Procedure: 

Nanodrop 

(Room 2) 

 
1. Turn on instrument. 

 
2. Lift the instrument arm and clean the upper and lower pedestals with DI water and a clean, lint free 

laboratory wipe. 
 

3. From the instrument home screen, select the Nucleic Acids application tab. 

 

4. Select the dsDNA application. 
 

5. Pipette 1 – 2 µl Ultrapure HPLC-grade water onto the lower pedestal and lower the arm. 
 

6. Tap Blank. 
 

7. Lift the arm and clear both pedestals with a new laboratory wipe. 

 

8. Pipette 1 – 2 µl of the sample onto the pedestal and lower the arm. 
 

9. Tap Measure. When complete, the spectrum and reported values are displayed. 
 

10. Record the concentration and the A260/280 values on the DICER1 QIACube and Nanodrop worksheet. 
 

11. After each measurement, lift the arm and clean both pedestals with a new wipe to prevent carryover. 
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NOTE: Wiping the sample from both the upper and lower pedestals upon completion of each sample 

is usually sufficient to prevent sample carryover and avoid residue buildup. 2 µl of DI water can be used 

to clean the measurement surfaces after particularly high concentration samples are measured. 

 

12. Repeat steps 7-11 for all samples. 

 

13. Once all samples have been measured, tap End Experiment. Optional: Name and save your experiment 

along with Sample names.  

 

14. Clean measurement surfaces with de-ionized water after the  last measurement: 

a. Apply 5 µl of dH2O onto bottom pedestal. Lower the upper pedestal arm to form a column and 

let sit for 2 – 3 minutes. Wipe away the water from both the upper and lower pedestals with a 

clean lab wipe. NOTE: Do NOT use a squirt bottle to apply de-ionized water 

 

15. Turn off instrument. 

 

For additional information, maintenance and troubleshooting, consult the Nanodrop Procedure. 
Assay Procedure: 

Sample Dilution 

(Room 2) 

NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by DI water and alcohol before 
and after any sample processing  

 
1. Enter the hand-written concentrations and the A260/280 values into the digital version of the worksheet, 

SharePoint – Lab – Documents – Molecular – Molecular Pathology – Agena-Dicer1 – Forms and 
Worksheets – DICER1 QIAcube and Nanodrop Worksheet. Dilutions will be automatically calculated 
once the concentrations are entered into the DICER1 QIACube and Nanodrop worksheet. 
 

2. If the concentration is greater than 100 ng/uL then a 1:10 dilution will be calculated. The word “yes” or 
“no” will populate to indicate the necessity of a 1:10 dilution. 
 

3. Label 1.5 mL tubes with Specimen ID on the side and the QIACube number and “1:10” on the cap for 
all samples that generated a 1:10 dilution and place in rack. 
 

4.  Add 18 uL of Ultrapure HPLC-grade water into each tube. 
 

5. Add 2 uL of each extract into the corresponding tube. 
 

6. Vortex and centrifuge briefly. 
 

7. In a rack, organize all samples in order that will be used to make the final 5 ng/uL dilution, either the 
original extract (< 100 ng/uL) or the prepared 1:10 dilution (> 100ng/uL). 
 

8. Label 1.5 mL tubes with Specimen ID on the side and the QIACube number and “5 ng/uL” on the cap 
for all samples and place in rack. 
 

9. Add Ultrapure HPLC-grade water to the “5 ng/uL” tubes according to volumes on worksheet. 
 

10. Add sample (either original extract or 1:10 dilution) to the “5ng/uL” tube according to the “Extract volume” 
field on worksheet.  
NOTE: Only open one set of corresponding tubes at a time. 

 
11. Vortex and centrifuge briefly. 

 
12. Discard “1:10” dilution tubes in biohazard waste. 

 
13. Store original extract in -70° C freezer. 

 

https://starnet.childrenshc.org/References/labsop/molpath/nanodrop/mp-2.02-nanodrop-onec-spectrophotometer-nucleic-acid-quantitation.pdf
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14. If moving on to Sample Addition the same day, store the “5ng/uL” dilutions in the refrigerator, otherwise, 
store in -70° C freezer. 

 
 

Assay Procedure:  

Option 1 - 

Automated 

Sample  and 

Master Mix 

Addition 

Performed by 

epMotion 5073 

IMPORTANT: This section is for automated sample and master mix addition performed by the epMotion 5073. 
Skip to Option 2 for the manual procedure. 
 
NOTE: Place the Thermorack TMX in the fridge until epMotion 5073 setup 
 

1. Prepare Plate Map and Master Mix Calculator. 

a. SharePoint – Lab – Documents – Molecular – Molecular Pathology – Agena-Dicer 1 – Forms 
and Worksheets – DICER1 Plate Map and Calculator 

 
2. Type in sample names and controls in the “Samples” tab at the bottom. 

 
3. Click the “1Plate” tab and change the run name in the upper left corner, e.g. 030320DICER1 

 
4. Click on the “Run Prep Sheet” tab and fill in the Date and Run Name.  

              NOTE: Fill in Lot# and Exp at each step. 
 

5. Print the “1Plate”, “Run Prep Sheet” and “Singlet DICER1 Calculator” tabs 
NOTE: Fill in Date, Tech and Thermocycler fields on the Singlet DICER1 Calculator at each step 

 
6. Click File-Create a Copy-Create a Copy Online  →  change name, e.g. 030320 DICER1 Plate Map and 

Calculator and then delete “Copy” from the name 
 

7. Click the “Choose Location” dropdown box and click “More save locations” 
 

8. Click the path as follows: Lab-Molecular-Molecular Pathology-Agena-DICER1-Forms and Worksheets-
DICER1 Run Worksheets-DICER1 Runs (current year) 
 

9. Click “Save Here” 
 

10. Take all printed worksheets to Room 1. 
 

11. Clean the Room 1 hood with 5% Extran followed by 70% ethanol. 
 

12. Pull the PCR reagents listed in the Table below to thaw. Leave Enzyme in freezer until needed. 
 

13. Once other reagents have thawed, take enzyme out of freezer and place in cold block. 
 

14. Vortex all reagents except the enzyme (flick), quick spin and place in cold block. 
 

15. Label seven 1.5 mL tubes, one MMX and the remaining 1-6, place in cold block. 
 

16. Prepare the PCR master mix (cocktail) in the MMX labeled 1.5 mL tube by adding reagents in order, as 
listed in the table below. Write how many tests are being removed on the white board in room 1. When 
opening a new box, write the numbers 1 through 5 on top of each vial as corresponds to the table below. 
 

17. Once the PCR (MMX) cocktail has been prepared, evenly distribute into Tubes 1-6 according to the 
calculator. 
 

18. Add each PCR Primer Set to the corresponding labeled tube. 
 

19. Vortex and spin tubes briefly. 
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Reagent  Per Reaction (uL) 

1. Ultrapure HPLC-grade Water 0.80 

2. 10x PCR Buffer 0.50 

3.  MgCl2 0.40 
4. dNTP mix 0.10 

5. PCR Enzyme 0.20 

PCR (MMX) Cocktail Final Volume 2.00 
Split MMX across Tubes 1-6 PCR (MMX) Cocktail Final Volume/6 

6. PCR Primers (1-6 accordingly) 1.00 

PCR Cocktail (MMX + Primer) Final Volume 3.00 
Sample DNA/Positive Control/Negative Control 2.00 

PCR Total Reaction Volume 5.00 

NOTE: reagent volumes on the worksheet allow for 25% overage 
             NOTE: The worksheet calculates volumes accordingly  
 

20. Bring the Master Mix in the cold block into Room 2 for dispersal. 
NOTE: If for any reason transfer of the master mix is delayed, place the entire block in the fridge 
 

NOTE: Leave the Master Mix Calculator worksheet in Room 1 for SAP and iPLEX Pro Extension Cocktail prep 
below. 
 

21. If frozen, thaw samples. 
 

22. Turn on epMotion computer if necessary. 
 

23. Turn on epMotion 5073. 
 

24. Double click epBlue 50.0 sofware 
Note: Username: bioapps 
          Password: Bioapps123! 
 

25. Click Application Runner under Application Library 
 

26. Highlight BioApps 
 

27. From the middle pane, highlight “DICER set up- from bottom tolerance 3/10/2025” 
 

28. Click Next 
 

29. Make sure 5073MK710035 is highlighted 
 

30. Click Next 
 

31. The Air Filter System pane will appear, click Start 
 

32. Click Next 
 

33. Click Next 
 

34. Enter the number of samples, including controls 
 

35. Click OK 
 

36. Click Next  
 

37. Load the deck according to the layout on the screen 
 



                Document: MP 4.01  Agena MassARRAY DICER1 Assay           

                Version: 3   
                Effective Date: 4/28/2025  

 

Page 12 of 24 
 

38. Take the Thermorack TMX out of the fridge and place it in position C2 on the deck 
 

39. Click on each master mix or sample listed in the Volume Input table and a position will be highlighted in 
the Vessels pane. Add master mixes and samples to the Thermorack TMX as indicated. 

 
40. Label a 96-well PCR plate with the Run name: “date, DICER1” 

 
41. Place the 96-well PCR plate on the Thermoadapter in position C1 

 
42. Place 50 uL tips in positions B1 and B2 

             Note: partial boxes can be used; the software will indicate if more tips are needed. 
 

43. Ensure there is enough room in the waste container 
 

44. Click Run 
 

45. Instrument will scan all consumables and reagents. It will alert if there is a missing requirement. Respond 
to the instrument message and rescan. If nothing is wrong after repeated scan, click ignore. 
 

46. Clean hood and supplies with a 1:10 bleach dilution or wipes followed by DI water and alcohol 
 

47. Once the run is complete, place 96-well plate in a plate holder in the hood 
 

48. Discard master mix tubes in the waste container 
 

49. Freeze samples in designated box 
 

50. Put lids on the tip boxes 
 

51. Wipe down deck with alcohol, turn on UV light and change gloves 
 

52. Manually add 2.0 uL of the controls to designated wells of the plate according to plate map 
 

53. Seal the PCR reaction plate, briefly pulse vortex 1-2 times, then do a quick spin in the centrifuge by 
bringing up to 1200 rpm.  

NOTE: Crease all four sides with the paddle.  
NOTE: Visually inspect the individual wells from the bottom of the reaction plate to confirm 
uniformity before continuing.  
 

54. Place the plate in the cold block and move to Room 3 to start thermal cycling. 
 
NOTE: Skip to PCR Amplification (Room 3)  
 
 

Assay Procedure:  

Option 2 -  

Manual Sample 

Addition (Room 2) 

 

IMPORTANT:  This section is for manual sample and master mix addition. See to Option 1 for the automated 
procedure. 
NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by DI water and alcohol before 
and after any sample processing 

 
55. Prepare Plate Map and Master Mix Calculator. 

a. SharePoint – Lab – Documents – Molecular – Molecular Pathology – Agena-Dicer 1 – Forms 
and Worksheets – DICER1 Plate Map and Calculator 

 
56. Type in sample names and controls in the “Samples” tab at the bottom. 

 
57. Click the “1Plate” tab and change the run name in the upper left corner, e.g. 030320DICER1 
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58. Click on the “Run Prep Sheet” tab and fill in the Date and Run Name.  

              NOTE: Fill in Lot# and Exp at each step. 
 

59. Print the “1Plate”, “Run Prep Sheet” and “Singlet DICER1 Calculator” tabs 
NOTE: Fill in Date, Tech and Thermocycler fields on the Singlet DICER1 Calculator at each step 

 
60. Click File-Create a Copy-Create a Copy Online  →  change name, e.g. 030320 DICER1 Plate Map and 

Calculator and then delete “Copy” from the name 
 

61. Click the “Choose Location” dropdown box and click “More save locations” 
 

62. Click the path as follows: Lab-Molecular-Molecular Pathology-Agena-DICER1-Forms and Worksheets-
DICER1 Run Worksheets-DICER1 Runs (current year) 

 
63. Click “Save Here” 

 
64. Take the “Run Prep Sheet” and “Singlet DICER1 Calculator” to Room 1 and “1Plate” to Room 2.  Save 

“File for MassARRAY” to a flash drive for instrument set up at the end 
 

65. Label a 96-well PCR plate with the Run name:  “date, DICER1” 
a. e.g. March 3, 2020 = 03.03.20 DICER1. Place in cold block. 

 
66. Divide and mark plate based on Primer Set layout according to plate map. 

 
67. Add 2.0 uL of either sample or control to designated well of the plate according to plate map. 

NOTE: The NTC and each sample will be pipetted six times, once for each primer set. 
NOTE: Controls are primer set based thus pipetted only once and are routinely rotated. Do not vortex 
synthetic positive QC. Thaw and quick spin only. 
NOTE: A previously tested positive sample needs to be run for each primer set for new lots/shipments. 
 

68. Seal the PCR plate and place in fridge until master mix is prepared. 
NOTE: Visually inspect the individual wells from the bottom of the reaction plate to confirm uniformity 
before continuing. 
 

Assay Procedure:  

Option 2 cont. -  

PCR Master Mix 

Preparation (Room 

1): 

 

1. Clean hood with 5% Extran followed by 70% ethanol. 
 

2. Pull the PCR reagents listed in the Table below to thaw. Leave Enzyme in freezer until needed. 
 

3. Take enzyme out of freezer and place in cold block. 
 

4. Vortex all reagents except the enzyme (flick), quick spin and place in cold block. 
 

5. Label seven 1.5 mL tubes, one MMX and the remaining 1-6, place in cold block. 
 

6. Prepare the PCR master mix (cocktail) in the MMX labeled 1.5 mL tube by adding reagents in order, as 
listed in the table below. Write how many tests are being removed on the white board in room 1. When 
opening a new box, write the numbers 1 through 5 on top of each vial as corresponds to the table below.  
 

7. Once the PCR (MMX) cocktail has been prepared, evenly distribute into Tubes 1-6 according to the 
calculator. 
 

8. Add each PCR Primer Set to the corresponding labeled tube. 
 

9. Vortex and spin tubes briefly. 
 

10. Label 0.2 mL PCR strip tubes with designated primer set and place in cold block. 
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11. Evenly aliquot cocktail from Tubes 1-6 into corresponding labeled strip tube according to the calculator 
worksheet. 
 

12. Cap tubes and spin briefly. 
 

Reagent  Per Reaction (uL) 

1. Ultrapure HPLC-grade Water 0.80 
2. 10x PCR Buffer 0.50 

3.  MgCl2 0.40 

4. dNTP mix 0.10 
5. PCR Enzyme 0.20 

PCR (MMX) Cocktail Final Volume 2.00 

Split MMX across Tubes 1-6 PCR (MMX) Cocktail Final Volume/6 

6. PCR Primers (1-6 accordingly) 1.00 
PCR Cocktail (MMX + Primer) Final Volume 3.00 

Sample DNA/Positive Control/Negative Control 2.00 

PCR Total Reaction Volume 5.00 
 

NOTE: reagent volumes on the worksheet allow for 25% overage 
             NOTE: The worksheet calculates volumes accordingly  

 
13. Bring the Master Mix in the cold block into Room 2 for dispersal. 

NOTE: If for any reason transfer of the master mix is delayed, place the entire block in the fridge. 
 
NOTE: Leave the Master Mix Calculator worksheet in Room 1 for SAP and iPLEX Pro Extension Cocktail 
prep below. 

  
Assay Procedure:  

Option 2 cont. -  

Master Mix 

Dispersal (Room 

2) 

 

1. Take the sample plate out of the fridge, carefully remove seal and change gloves. 
 

2. Using a multi-channel pipet, add 3.0 uL of master mix to the sample plate according to the map, changing 
tips each time. 
 

3. Seal the PCR reaction plate, briefly pulse vortex 1-2 times, then do a quick spin in the centrifuge by 
bringing up to 1200 rpm.  

NOTE: Crease all four sides with the paddle.  
NOTE: Visually inspect the individual wells from the bottom of the reaction plate to confirm 
uniformity before continuing.  
 

 
4. Place the plate in the cold block and move to Room 3 to start thermal cycling. 

 
Assay Procedure: 

PCR Amplification 

(Room 3) 

 
NOTE: Turn on the thermocycler so that the heated cover can come to the correct operating temperature and 
there is no time delay between the PCR reaction plate being prepped and cycling being started.  
 

1. Place plate in the thermocycler (rotate usage).  Run program DICER-PCR.  See the Table below for 
program details.    
NOTE: Total volume: 5.0 uL 
NOTE: Cycle program takes approximately 2 hour and 20 minutes in Veriti 

Step Temperature Time Number of Cycles 

1 Initialization 95°C  5 minutes 1 cycle 

2 Denaturation 95°C  30 seconds     

3 Annealing 56°C  30 seconds 45 cycles of steps 2-4 

4 Extension 72°C  1 minute     
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5 Final extension 72°C  5 minutes 1 cycle 

6 Sample preservation 4°C  -- Hold 

 
NOTE: If not proceeding directly to the next step, the reaction plate should be sealed and stored at 4 °C – 10 
°C  (if storing for less than 24 hours), or at -20 °C (if storing for more than 24 hours).  Do not store for more 
than 2 weeks.  
 

Assay Procedure: 

Shrimp Alkaline 

Phosphatase 

(SAP) Cocktail 

Preparation (Room 

1) 

 
1. Pull the reagents listed in the Table below to thaw to room temp.  Vortex all reagents except enzyme 

(flick) and quick spin.   
NOTE: Leave enzymes in the freezer until use, and keep in a cold block when pipetting. 
 

2. In a cold block, prepare the SAP cocktail in a labeled 1.5 mL tube by adding reagents in order, as listed 
in the table below.  

 
 
 

Reagent Per 
reaction 
(uL) 

1. Ultrapure HPLC-grade water 1.53 

2. SAP Buffer 0.17 
3. Shrimp Alkaline Phosphatase (SAP) 0.30 

SAP Cocktail Final Volume 2.00 

 
NOTE: reagent volumes on the worksheet allow for 25% overage 
NOTE: The worksheet calculates volumes accordingly 
 

3. Pulse vortex the tube briefly 3 times and quick spin. 
 

4. Label 0.2 mL PCR strip tubes and place in cold block. 
 

5. Evenly aliquot SAP master mix into strip tubes according to calculator. 
 

6. Immediately bring to Room 3 for dispersal. 
 
NOTE: Leave the Master Mix Calculator worksheet in Room 1 for iPLEX Pro Extension Cocktail prep below. 
 

Assay Procedure: 

SAP Cocktail 

Addition to 

Samples (Room 3) 

NOTE: If plates were stored frozen prior to this step, make sure they are thawed completely, gently 
homogenized, spun down, and kept in a cold block 
 
NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by DI water and alcohol before 
and after adding the cocktail  
 

1. Perform a quick spin of the PCR reaction plate in the centrifuge by bringing up to 1200 rpm. 
 

2. Remove and discard seal. Change gloves.   
NOTE: Take care when removing seal: do not let it curl back onto the plate or fold into itself.  
 

3. Using a multi-channel pipet, dispense 2.0 uL of SAP cocktail into each well of the reaction plate, 
changing tips each time.  
 

4. Seal the reaction plate, briefly pulse vortex 1-2 times, then perform a quick spin in the centrifuge by 
bringing up to 1200 rpm. 
NOTE: Crease all four sides with the paddle. 
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NOTE:  Visually inspect the individual wells from the bottom of the reaction plate to confirm uniformity 
before continuing.     
 

5. Place the plate with compression pad in the thermocycler and run program DICER-SAP.  See the table 
below for program details. 
NOTE: Total volume: 7.0 uL 
NOTE: Cycle program takes approximately 45 minutes 
 

    

Step Temperature Time Number of Cycles 

1 Dephosphorylation 37°C  40 minutes 1 cycle 

2 Enzyme inactivation 85°C  5 minutes 1 cycle 

3 Sample preservation 4°C  -- Hold 

 
 
NOTE: If not proceeding directly to the next step, the reaction plate should be sealed and stored at 4 °C – 10 
°C  (if storing for less than 24 hours), or at -20 °C (if storing for more than 24 hours).  Do not store for more 
than 2 weeks.  
 

Assay Procedure: 

iPLEX Pro 

Extension Cocktail 

Prep 

(Room 1) 

 

 
1. Pull the reagents listed in the Table below to thaw. Vortex all reagents except enzyme (flick) and quick 

spin.  
NOTE: Leave enzymes in the freezer until use, and keep in a cold block when pipetting. 
 

2. Label 7 1.5 mL tubes, one MMX and the remaining 1-6, place in cold block 
 

3. In a cold block, prepare the iPLEX Pro Extension master mix (cocktail) in the MMX labeled 1.5 mL tube 
by adding the reagents in order, as listed in the table below. When opening a new box, write the number 
1 through 4 on the top of each vial as corresponds to the table below. 
 

4. Once the Extension (MMX) cocktail has been prepared, evenly distribute into Tubes 1-6 according to 
the calculator. 

 
5. Add each Extend Primer Set to corresponding labeled tube. 

 
6. Vortex and spin tubes briefly. 

 
7. Label 0.2 mL PCR strip tubes with designated primer set and place in cold block. 

 
8. Evenly aliquot cocktail from Tubes 1-6 into appropriately labeled strip tube according to the calculator 

worksheet. 
 

9. Cap tubes and spin briefly. 
 
 

Reagent Per reaction (uL) 
1. Ultrapure HPLC-grade water 0.62 

2. iPLEX Buffer Plus, GPR 0.20 

3. iPLEX Termination Mix 0.20 

4.  iPLEX Pro Enzyme 0.04 
Extension (MMX) Cocktail Final Volume 1.06 

Split MMX across Tubes 1-6 Extension Cocktail Final Volume/6 

EXTEND Primers (1-6 accordingly) 0.94 
Extension (MMX + Primers) Final Volume 2.00 

NOTE: reagent volumes on the worksheet allow for 25% overage 
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NOTE: The worksheet calculates volumes accordingly 
 

10. Bring the Master Mix in the cold block into Room 3 for dispersal. 
NOTE: If for any reason transfer of the master mix is delayed, place the entire block in the fridge.  

 
Assay Procedure: 

iPLEX Pro 

Extension Cocktail 

Addition to 

Samples (Room 3) 

 

 
NOTE: If plates were stored frozen prior to this step, make sure they are thawed completely, gently 
homogenized, spun down, and kept in a cold block 
 
NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by DI water and alcohol before 
and after adding the cocktail  
 

1. Perform a quick spin of the PCR reaction plate on the centrifuge by bringing up to 1200 rpm. 
 

2. Remove and discard seal. Change gloves. 
NOTE: Take care when removing seal: do not let it curl back onto the plate or fold into itself.  
 

3. Using a multi-channel pipet, dispense 2.0 uL of extension cocktail into designated wells of the reaction 
plate according to plate map, changing tips each time. 
  

4. Seal the reaction plate, briefly pulse vortex 1-2 times, then perform a quick spin on the centrifuge by 
bringing up to 1200 rpm. 
NOTE: Crease all sides, corners and between wells with the paddle. 
NOTE: Visually inspect the individual wells from the bottom of the reaction plate to confirm uniformity 
before continuing.   
 

5. Place the plate along with compression pad in the thermocycler and run program DICER-Extension. 
See the table below for program details. 
NOTE: Total volume: 9.0 uL 
NOTE: Cycle program take approximately 2 hours and 30 minutes 
 

Step Temperature Time Number of Cycles 

1 Initialization 95°C  30 seconds 1 cycle 

2 Denaturation 95°C  5 seconds   

40 cycles 3 Annealing 52°C  5 seconds 
5 cycles 

4 Extension 80°C  5 seconds 

5 Final extension 72°C  3 minutes 1 cycle 

6 Sample preservation 4°C  -- Hold 

 
 
NOTE: If not proceeding directly to the next step, the reaction plate should be sealed and stored at 4 °C – 10 
°C  (if storing for less than 24 hours), or at -20 °C (if storing for more than 24 hours).  Do not store for more 
than 2 weeks.  
 

Assay Procedure: 

Water Addition 

(Room 3) 

 
NOTE: If plates were stored frozen prior to this step, make sure they are thawed completely, gently 
homogenized, spun down, and kept in a cold block 
 
NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by DI water and alcohol before 
and after adding the cocktail  
 

1. Perform a quick spin of the reaction plate on the centrifuge by bringing up to 1200 rpm. 
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2. Discard and remove seal.  Change gloves.   
NOTE: Take care when removing seal: do not let it curl back onto the plate or fold into itself. 
 

3. Using a multi-channel pipet, add 41.0 uL Ultrapure HPLC-grade water to each well of the reaction plate, 
changing tip each time.  

 
4. Seal the plate and perform a quick spin of the reaction plate on the centrifuge by bringing up to 1200 

rpm. 
NOTE: Crease all four sides with the paddle. 

 
NOTE: If not proceeding directly to the next step, the reaction plate should be sealed and stored at 4 °C – 10 
°C  (if storing for less than 24 hours), or at -20 °C (if storing for more than 24 hours). Do not store for more 
than 2 weeks.  
 

Creating a plate in 

the MassARRAY 

Software  

Create a Sample Group  
1. Open the MassARRAY Typer Plate Editor software, log in.  

a. User: charles 
b. Password: darwin 

 
2. Click on the Sample view tab. 

 
3. Expand the customer and project (DICER1->Registry Samples). Right-click on the sample project that 

you want to add the sample group to and select Add New Sample Group. 
 

4. Enter the Experiment/Run name and click the folder button in the toolbar to browse to the location of 
your sample group text file, and click Open, then click OK. Check sample IDs and QC IDs against plate 
set up sheet for accuracy.  
NOTE: properties – select “Horizontal” and “Keep Selected Region True” 

 
Create a Project & Plate 

1. In the MassARRAY Typer Plate Editor software, click on the Plate tab. 
 

2. Create a plate. 
a. Right-click on the project (DICER1->Registry Samples) that you want to add the plate to and 

select New Plate. 
b. Enter the Experiment/Run name and select the plate type (96- or 384-well) and click OK. 
c. The new plate will appear in the Plate tab and a plate layout will be created automatically, based 

on the plate type specified. 
 

Apply Assays to the Plate 
1. In the Plate tab, select the plate that was just created. 

 
2. Select the Assay View tab at the bottom and in the plate layout. 

 
3. Select wells for Primer set 1 based on the plate map worksheet. 

 
4. Expand the assay design file. 

 
5. Right click on the test tube “1” icon and select add plex 1. 

 
6. Repeat steps 3-5 for each of the 6 Primer sets. 

 
Apply Samples to the Plate 

1. Click on the Sample View tab. 
 

2. In the plate layout, select all the wells in which a “plex” number has been added. 
 

3. Right-click the plate, right click “Apply Samples from Group”…, choose file from the flash drive. 
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4. Check plate locations with sample IDs and QC IDs against plate set up sheet for accuracy. 

 
5. Select File > Save from the toolbar. 

 
Assay Procedure: 

Creating an Input 

File (Room 3) 

 
1. Double-click the Chip Linker icon on the desktop. 

 
2. In the dialog box that appears, enter your username, password, and server. 

a. User: charles 
b. Password: darwin 

 
3. Click Connect. The Chip Linker window appears. 

 
4. Select a plate in the Chip Linker directory tree (DICER1->Registry Samples). 

 
5. Select iPLEX as the terminator chemistry. 

 
6. Select Allelotype for the process method. 

 
7. Select Nanodispenser 96 to 96 as the dispenser method. 

 
8. Enter the Experiment/Run name. 

 
9. Enter the SpectroCHIP Array barcode or other SpectroCHIP Array identifier. Record chip ID on the Run 

Worksheet. 
 

10. Click Add. The input information appears in the Chip Linker table. 
 

11. If a second SpectroCHIP Array will be processed, repeat step 4 to step 10 for the second SpectroCHIP 
Array. 
 

12. Click Create to create an input XML file. This file will be selected for use when you set up the automatic 
run. 

 
Assay Procedure: 

Preparing the 

Instrument (Room 

3) 

 
NOTE: Ensure the daily maintenance has been performed prior to advancing.  
 

1. In the Status section in the Run Setup tab of SpectroACQUIRE check the Waste Tank, System Fluid, 
and Resin buttons; they should be green/Okay. If any are red (Waste Tank Full, System Fluid Empty, 
Resin Low or Empty) perform the necessary maintenance. 
 

2. Click Chip prep module Deck In/Out at the top of the SpectroACQUIRE window. The deck will extend. 
 

3. If there are SpectroCHIP Arrays in the completed chips position on the deck remove them. 
NOTE: the completed position is the deck that is closer to you 
NOTE: a used chip is always needed on the right side of the chip holder for balance 
 

4. Allow the calibrant to equilibrate to room temperature for 5 minutes (if it has been refrigerated) or 10 
minutes (if it has been frozen). Quick spin and pipette 75 μL of calibrant into the calibrant vial and place 
in the calibrant vial holder on the deck. 
 

5. Load the SpectroCHIP Arrays. 
a. Orient the Chip holder so that the beveled corner is at the top right. 
b. Open a new SpectroCHIP Array pouch and insert the new SpectroCHIP Array into the chip 

holder in position 1 (on the left); orient the SpectroCHIP Array such that the Agena logo and 
barcode are at the bottom. Make sure that the SpectroCHIP Array is properly seated so that 
the chip holder and SpectroCHIP Array surface are flush. 



                Document: MP 4.01  Agena MassARRAY DICER1 Assay           

                Version: 3   
                Effective Date: 4/28/2025  

 

Page 20 of 24 
 

NOTE: Use flat tweezer for transfer and pointed tweezer for any necessary adjustments  
NOTE: Care must be taken to avoid touching the surface 
NOTE: Chips may be sent on counter on top of a kim wipe  
NOTE: Save the SpectroCHIP Array pouch and holder if chip will not be completely 
used.  Write the open date on the pouch.  

c. If you are processing two plates, insert another new SpectroCHIP Array into the chip holder in 
position 2 (on the right). If you are only processing one plate, place a previously completed 
SpectroCHIP Array in position 2, as the MassARRAY Analyzer requires both SpectroCHIP Array 
positions to be filled to function properly. 

d. Place the full chip holder in the chip holder tray, new chips position, on the deck. 
 

6. Load microtiter plates (MTPs). Up to two 96-well microtiter plates of analyte may be loaded. 
a. Quick spin the microtiter plate(s) at ~1200 – 1500g 
b. Remove the seal, change gloves, and place the first MTP on MTP holder 1 (on the left). This 

corresponds to chip position 
i. Orient the plate such that well A1 is in the front left corner (match to label on instrument 

loading deck) 
c. If a second MTP is being processed, place it on MTP holder 2 (on the right). This corresponds 

to chip position 2. 
 

7. Click Chip prep module Deck In/Out again to retract the deck. 
 

Assay Procedure: 

Setting up and 

Starting the Run 

(Room 3) 

 
1. Select the Run Setup tab in SpectroACQUIRE. 

 
 

2. In the Analyzer Setup section: 
a. In the Experiment Setup section: 

i. Under MTP 1, click on the browse button next to Experiment Name and select the XML 
input file created earlier. 

ii. In the Wells to Process field, select Automatic. 
iii. Repeat steps 1 and 2 for MTP 2 if running two plates. Otherwise, select None in the 

Experiment Name and Wells to Process fields for MTP 2. 
b. Make sure all settings are as shown in the Table below. 

 

 SpectroCHIP CPM-96 
Use Autotune NOT selected 

Start Dispense Condition 600 

Resin Volume 13 
Sample Volume n/a 

  

Shots (n) 30 
Maximum acquisitions 9 

Minimum good spectra 5 

Maximum good spectra 5 

Turn off HV After Analysis Selected 
Analyze Calibrant Pads Selected 

Filter Saturated Shots NOT selected 

Chip Type SpectroCHIP CPM-96 
 

 
3. In the Chip Prep Module Setup section: 

a. Check the Normal Operation box. 
i. If NOT running 2 plates: unselect “Transfer Resin to MTP2” 

NOTE: if rerunning a plate that has already been spotted unselect “Transfer Resin to 
MTP1 and/or MTP2” 

b. Select iPLEX in the Chemistry drop-down menu. 
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4. In the Temperature Control section: 

a. If the run will sit on the instrument overnight, select the MTP Cool box, and check the Auto box. 
b. If using a SpectroCHIP CPM-96, check the Chip Heat box and enter 30 in the Setpoint field. 

 
5. Click Start Chip prep module to start the run. Approximate run time is 1 hour and 40 minutes. 

 
Assay Procedure: 

Removing plates, 

calibrant and 

SpectroCHIP Array 

when run is 

complete  

 
1. Once the run is completed, click Remove Old Chips from MA4 in the Run Setup tab. The instrument 

will move the completed SpectroCHIP Arrays from the MassARRAY Analyzer to the completed chips 
position on the Chip Prep Module deck, and then extend the deck so you may remove the SpectroCHIP 
Arrays from the completed chips position. 
NOTE: save incompletely used chips in saved holder and pouch with the desiccant. Write the open date 
and which wells have been used on the outside of the pouch. Seal with tape.  
 

2. Remove the MTPs and calibrant vial. 
a. Pipette remaining calibrant into a 2 mL cryovial labeled with the calibrant lot number, expiration 

date, and date the vial was created 
b. Freeze calibrant for future use 
c. Rinse calibrant tube with DI water: 

i. Pipette 100 uL DI water and mix 5-8 times  
d. Store MTP in freezer for two weeks and then discard in red biohazard waste 

 
3. Click Chip prep module Deck In/Out to move the deck in.   

 
Assay Procedure:  

Recalling Chip to 

Create a 

Genotype+Area 

Report  

 
1. Create a folder with the run’s name (mm.dd.yy DICER1) in Documents 
2. Open Chip Linker (log in if necessary): 

a. Select the plate from the folder tree 
b. Settings: iPlex, Genotype+Area, Nanodispenser 96 to 96 
c. Name the experiment exactly as the Allelotype run 
d. Enter Chip ID 

3. Click Recall and select the correct chip from the pop-up window 
4. Open Typer to display recalled chip 
5. Find run according to date 

 
 

Analyzing Data   
6. In the Project Explorer pane double click on the Allelotype (blue font) and Genotype+Area (magenta font) 

SpectroCHIP Arrays. The SpectroCHIP Arrays will be added to the Chip List. 
 

7. Check the box next to Genotype + Area in the Chip List. 
 

8. Save a picture (Snip tool) of the GenotypeArea "traffic light" diagram in the newly created dated folder in 
Documents. 

a. Note: If any well is NOT dark green (except for wells with known synthetic controls or NTC) notify 
the molecular pathologist. Ensure optimal threshold (dark green) is set at 100. 

  
9. Ensure positive, negative, and no template controls gave expected results. 

a. Note: If any control is not as expected, notify the molecular pathologist and save original plate and 
chip for potential troubleshooting and/or repeat run. 
 

10. While still on the GenotypeArea chip, select File > Reports > Typer Reports > GenotypeArea Report-v1 
in the MassARRAY Typer Analyzer menu bar. 

 
NOTE: When the report is complete, it will automatically open in OpenOffice. Save this file as a .xls in an 
appropriately dated folder in the same folder as the GenotypeArea traffic light picture above, keeping the 
generated name. 
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11. Load the Allelotype chip and select File > OncoPanel Reports > CHMN_DICER1_v1.0-v1 in the 

MassARRAY Typer Analyzer menu bar. Save these files in the same folder as the GenotypeArea traffic light 
picture and report as above.   
 

12. Save (drag and drop) the dated folder containing the GenotypeArea traffic light picture and report and 
OncoPanel reports to a USB thumb drive. Remove USB. 

  
13. Insert USB into a networked computer. save files located here:  

 
14. Go to SharePoint\Lab\Documents\Molecular\Molecular Pathology\Agena - Dicer 1\Results – folder by year 

 
15. . Create new folder (mm.dd.yy DICER1) 

 
16. Save (drag and drop) files from the USB to the new folder 

 
Files to be included: 

a. GenotypeArea.xls 
b. Traffic light 
c. (Allelotype) OncoReport.tsv 
d. (Allelotype) OncoReport mutation list 
e. (Allelotype) OncoReport uncertain mutation list 
f. Plate map and calculator (with lot numbers and expiration dates) 
g. QiaCube and Nanodrop (with lot numbers and expiration dates) 

i. To save the Plate map and calculator and QiaCube and Nanodrop worksheets to the new 
folder: 

1. Open worksheet (Sharepoint-Lab-Documents-Molecular-Molecular Pathology-
Agena-Dicer 1-Forms and Worksheets) 

2. File 
3. Save As 
4. Save a Copy 
5. Expand “Choose Location” drop down box 
6. Click “More save Locations” 
7. Click Lab-Molecular-Molecular Pathology-Agena-Dicer 1-Results-(folder by year) 
8. Save here 
9. Rename so the date is in front of the file name and the “copy” is removed at the end 
10. Make sure all information (including lot numbers and expiration dates) has been 

filled in on the Run Prep Sheet tab, Singlet DICER1 Calculator tab, and DICER1 
QIAcube and Nanodrop worksheet 

 
17. Notify pathologist of results available for review.  
  

Result 

Interpretation 

Interpretation of the results is performed by the molecular pathologist on service. 
 

Quality control and validity of results 
1. One no template control and one positive patient sample (or synthetic positive sample if patient sample 

is not available; rotating through a positive for each assay within a primer set set each run) for each 
primer set are processed with each run. 
NOTE: If any control fails, notify the molecular pathologist and store plates and chips while waiting for 
further instructions.  
 

 
 
 
 
NOTES on well colors: 
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There are 6 assays in each well. The color shown in the Typer software relates to the number of targets that 
were called (AKA: performed).   
Green = 100% called  
Light Green = 99% – 50% called  
Yellow = 49% - 16% called  
Red = 15% or less called  
 

Sample Storage  
Storage and Retention of Test Specimens 

1. Store eluates in positive or negative box (based on results) in the -80 °C freezer in Room 2.    
2. Store completed and sealed 96-well plates in the -20 °C freezer in Room 3.   
3. Discard samples in red biohazard container after molecular pathologist approval. 

 
 

Equipment and 

Room 

Decontamination 

Refer to:  
MB 3.03 Cleaning and Decontamination of Equipment and Work Areas 

 

Limitations 

 

 
1. The performance characteristics of the MassARRAY DICER1 panel have been evaluated by Children’s 

MN Laboratory. This is a RESEARCH USE ONLY assay.  
 
 

2. All results from this and other tests must be considered in conjunction with the clinical history, 
epidemiological data, and other data available to the clinician evaluating the patient. 
 

3. Samples must be collected, transported, and stored using appropriate procedures and conditions. 
Improper collection, transport, or storage of samples may hinder the ability of the assay to detect the 
target sequences. 
 

4. The performance of the DICER1 Agena MassARRAY Research Panel was established using extracted 
DNA from formalin fixed, paraffin-embedded tissue samples. 
 

5. This test is a qualitative test and does not provide the quantitative value of detected alleles present. 
 

6. There is a risk of false positive values resulting from: 
a. Non-specific signals in the assay. 
b. Cross-contamination during sample handling or preparation. 
c. Cross-contamination between patient samples. 
d. Sample mix up. 
e. DNA contamination during product handling. 

 
7. There is a risk of false negative values due to: 

a. The presence of sequence variants in the regions of interest of the assay, procedural errors, 
amplification inhibitors in samples, or inadequate tumor cellularity for amplification. 

b. Improper sample collection/preservation. 
c. Sample mix up. 
d. Degradation of sample DNA during shipping/storage. 
e. The presence of PCR inhibitors. 

 
8. This test cannot rule out potentially clinically relevant variants in parts of the genome not specifically 

targeted by the assay. 
 

9. Negative results do not preclude low-level clinically relevant variants and should not be the sole basis 
of a patient management decision. 
 

10. This panel has been evaluated for use with human sample material only. 
 

https://starnet.childrenshc.org/References/labsop/molbio/engctl/mb-3.03-cleaning-and-decontamination-of-equipment-and-work-areas.pdf
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Method 

Performance 

Specifications 

 

 

In-house performance (per the assay validation studies): 2x2 Table, FFPE Samples – overall arbitrated 

results 

Agena Expected result 
 

Positive  Negative 

Positive  37 1 

Negative 0 42 

 
Results (95% CI):  
Positive Percent Agreement: 100% (90.51% - 100.00%) 
Negative Percent Agreement: 97.67% (87.71% - 99.94%) 
Overall Percent agreement: 98.75% (93.23% - 99.97%) 
 
LoD: 0.02 TCID50/mL 
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Alternate Methods  
1. Send out test  

Proficiency 

Testing 

Not applicable. Research Use Only assay. 

 

Training Plan/ 

Competency 

Assessment 

 

Training Plan Initial Competency Assessment 

1. Employee must read the 

procedure. 

2. Employee will demonstrate the 

ability to perform procedure, 

record results, and document 

corrective action after 

instruction by the trainer. 

1. Direct observation 
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